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Preface

Welcome to the 4th Dimension.

From the time of its release in the mid-1980’s, 4D has been winning 
awards from the computer industry press and winning praise from 
users for its power, elegance, and simplicity. Millions of users and 
developers all around the world are using 4th Dimension to store data 
that is vital to their organizations.

What is the 4th Dimension? Albert Einstein, the great physicist, helped 
the world to see that Time is the fourth dimension. The name of our 
product is not a coincidence. Throughout six major versions and 
several dozen updates, the authors and publishers of the 4D family of 
products have held steadfastly to our mission—giving you, the user, 
the power to accomplish more, in less time.

As the first major graphical user interface relational database product 
on the Macintosh, 4th Dimension pioneered the concept of RAD—
Rapid Application Development. Now, with Version 6, we have taken 
Windows® and Macintosh™ RAD to a whole new level. 
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The tutorials in Discover 4th Dimension use the example of a personal 
music collection to build and work with a database. In the next two 
hours, using 4th Dimension and the tutorials, you will do all of the 
following:

■ Create a relational database to track your personal music collection.

■ Create custom Input and Output forms to view the data.

■ Import several hundred records of sample data.

■ Create and save your own custom queries.

■ Create a custom report to print a list of your albums.

■ Design your own labels for your CD holders.

■ Print three-dimensional charts to analyze your collection by type of 
music.

■ Create a multi-window, custom menu environment for your database.

■ Create Web-enabled forms for viewing the data on the Web.

■ Publish the database on the World Wide Web.

What is most remarkable is the fact that you will do all of this in 
4th Dimension, without using any add-on products, and by writing 
only two lines of programming code!

After you finish the tutorials, you will also find out how you can add 
even more power to the application—debug it; cross-reference it; 
compile it; serve it to multiple users; embed word processing, 
spreadsheet, and drawing functions into it; and connect it to back-end 
SQL databases—all with tools from the 4D family of products.

Welcome to the 4th Dimension.
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About Discover 4th Dimension
The four chapters in this manual are tutorials—step-by-step 
explanations—that show you how to use 4th Dimension to create 
useful databases. As you work through these tutorials, you will become 
familiar with many of the major features of 4th Dimension.

How to Use the 
Tutorials

It should take you no more than two hours to work through all the 
chapters. When you have finished Discover 4th Dimension, you can start 
building your own 4th Dimension databases.

You should work through the tutorials in order; the work you do in 
each chapter prepares the database for the work that you will do in the 
next. Each chapter begins with an estimate of how long it will take you 
to complete the work in it. Feel free to stop at the end of any chapter, 
take a break, and begin the next chapter by opening the database on 
which you have been working.

Tutorial Database We have provided “progressive copies” of the tutorial database. The 
copy labeled “Chapter2” picks up at the beginning of Chapter 2; 
“Chapter3” picks up at the beginning of Chapter3; and “Chapter4” 
picks up at the beginning of Chapter 4. If you misplace your work in 
the middle of the tutorial, you don’t have start over; just launch the 
appropriate progressive copy and continue to follow the tutorial.

Assumptions This manual assumes that you have already installed 4th Dimension as 
described in the 4th Dimension Installation Guide, and that you are ready 
to create a new database of your own.
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Conventions
This manual uses certain conventions to help you understand the 
material.

Steps and 
Explanations

The tutorials provide specific steps for you to follow, as well as general 
information that explains 4th Dimension. The format for steps and 
explanations looks like this:

1 A numbered step tells you what to do.
Following the numbered step, there may be a paragraph that offers an 
explanation or a comment.

2 Type “Smith” in the Last Name field.
A numbered step can contain the following special notations:

Database Terms All table names are shown in brackets in the text to help distinguish 
them from the names of fields, forms, and other items. For instance, 
the Albums table is written as the [Albums] table.

Notation Example Meaning

Quotation Marks Type “Smith” When a numbered step asks you to type 
something, the characters you should type 
are enclosed in quotation marks.Type 
exactly what is enclosed in the quotation 
marks, including any spaces or 
punctuation; however, do not type the 
quotation marks.

Underline in the Last Name 
field.

The underlined text tells you where to do 
something. You should locate that object 
or menu on the screen, and do what the 
step describes.
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Other Notation The tutorials also use the following explanatory notes:

Note Text emphasized like this provides annotations and shortcuts that will 
help you use 4th Dimension more productively.

4D Server Throughout the manual, 4th Dimension and 4D Server/4D Client are 
referred to simply as 4th Dimension. Differences between the operation 
of the two products are explained in 4D Server notes, which provide 
information about using 4D Server/4D Client. This information is 
provided only when the operation of 4D Server/4D Client differs from 
that of 4th Dimension.

Notes like this alert you to important pieces of information and alert 
you to situations where data might be lost.

In this manual, the names 4th Dimension and 4D are used 
interchangeably.

Cross-Platform 
Considerations

This manual explains the use of 4th Dimension on both the Windows® 
and Mac™OS (Macintosh and Power Macintosh) platforms. Although 
the concepts and functionality of both versions of 4th Dimension are 
nearly identical, the manual addresses any differences where necessary. 
Such differences may include the graphical user interface and keyboard 
commands.

The screen shots illustrate 4th Dimension in the Windows 95 
environment. The two versions of the same screen are only presented 
if there are any major differences between them.

This manual assumes that you are familiar with basic Macintosh or 
Windows operations, such as selecting objects, choosing menu items, 
clicking, dragging, and so on. For complete information and 
instructions, refer to the user guide or the on-line help that came with 
your computer.
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1 Creating a Database
with 4D

Estimated time to complete: 30 minutes

In this chapter, you will learn how to design a database using 
4th Dimension. You will also learn some of the database terminology, 
such as table, field, query, and index. When you have finished this 
chapter, you will know how to do the following:

■ Create a table, create fields, and change the properties of fields.

■ Create default input and output forms.

■ Create standard choice lists.

■ Enter new records and modify existing records.

■ Import records from a document on disk.

■ Find records in your database.

■ Index fields to improve search performance.

This chapter assumes that you have already installed 4th Dimension as 
described in the 4th Dimension Installation Guide, and that you are ready 
to create a new database of your own.
1Discover 4th Dimension



Chapter 1  Creating a Database with 4D
Creating a New Database
¨̈̈̈ To create your Music Collection database in 4th Dimension.

1 Launch 4D.exe (Windows) or 4th Dimension 6.0 (Macintosh).
You can double-click 4th Dimension, or select the 4th Dimension 
application and choose Open from the File menu.

4D displays the operating system’s standard Open File dialog.

2 Click the New… button to create a new database.
4D prompts you to name your new database.

3 Type the file name “MyMusic”.

4 Click the Save button.
4D prompts you for the name of the data file, and defaults to the name 
“MyMusic.4DD” on Windows and “MyMusic.data” on Macintosh.

Your 4th Dimension database will be composed of three files on 
Windows and two files on Macintosh. 

5 Click the Save button.

Macintosh Windows Description

MyMusic MyMusic.4DB Structure file containing forms, tables, 
methods

— MyMusic.RSR Part 2 of the structure file on Windows
MyMusic MyMusic.4DD The data file containing data and 

indexes
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Creating a New Database
You are now ready to begin building your database. When you create a 
new database, as you have done here, 4th Dimension opens in the 
Design environment and the User environment simultaneously. 

The structure window—part of the Design environment—is the 
frontmost window on the screen. This is the window in which you 
create the structure (the tables and fields) of your database.

As you work through the exercises in this manual, you will become 
familiar with both the Design and User environments and discover 
how easy it is to switch between them. For now, we will concentrate on 
the Design environment.

Toolbar

Table name

Structure window

User Environment
window
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Chapter 1  Creating a Database with 4D
Creating a Table
Now you are ready to create your database structure. In the structure 
window, note that 4th Dimension has created a default table and 
named it Table1.

Naming the Table This first table will store album information, so you should rename the 
table to something more descriptive of its contents. We will call this 
first table [Albums].

¨̈̈̈ To change the name of this table to Albums.

1 Double-click the table name Table1 in the Structure window.
The Table Properties dialog box appears.

2 Highlight the name Table1 and replace it with the name “Albums.”
For information about the other options in the Table Properties dialog 
box, see the 4th Dimension Design Reference.

3 Click the Apply button to save your changes.

4 Click the Done button to close the Table Properties dialog box.
The structure window displays the renamed table. You are now ready 
to create the fields for this table.

Creating Fields Let’s assume that you want to keep track of the album title, musician’s 
name, format (CD, tape, etc.), music category (jazz, rock, etc.), year 
recorded, date purchased, purchase price, and notes. In the case of 
classical albums, you also want to enter the name of the orchestra that 
performed the piece on that album. 
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Creating a Table
¨̈̈̈ To create fields:

1 Double-click the first box in the Fields area of the [Albums] table.
The Field Properties dialog box appears, with the Attributes tab 
window showing. The default name of this first field is Field1. We will 
rename this first field “Album Title.”

2 Change the field name to “Album Title.”

3 Make sure that the field type is Alpha.

4 Change the field length to 45 characters.

Your Field Properties dialog box looks like this:

Later in this tutorial, we will explain the other options in the Field 
Properties dialog box. For additional information about field 
properties, see the 4th Dimension Design Reference manual.

The Type pop-up menu tells 4th Dimension what kind of data to store 
in the field. Note that 4D assumes the first field to be type Alpha, 
which can store letters, numbers, and special characters—often called 
alphanumeric information. An Alpha field may contain between 2 and 
80 characters.

5 Click the Apply button.
When you click the Apply button, 4th Dimension saves the field 
definition information from Field1 and automatically adds a new field 
with the default name of Field2.

Fields 
area

Field Type pop-up menu

Field Length

Attributes tab
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Chapter 1  Creating a Database with 4D
6 Create the remaining fields for the [Albums] table.
Each time you create a field, you will do the following:

■ Type the field name.

■ Choose the field type from the pop-up menu.

■ Change the field length, if applicable.

■ Click the Apply button.

7 Click the Done button.
When you click Done, 4th Dimension closes the Field Properties dialog 
box.

In the structure window, the table definition for [Albums] now looks 
like this:

You are now ready to enter the User environment and test your table 
by actually entering and modifying data.

Field name Field type 
and length Type of data you can store in the field 

Musician Alpha 45 Alphanumeric Characters (Maximum 45)
Format Alpha 15 Alphanumeric characters (maximum 15)
Music Category Alpha 15 Alphanumeric characters (maximum 15)
Year Recorded Integer Whole numbers (no decimals)
Date Purchased Date Dates
Purchase Price Real Numbers with decimals
Notes Text Alphanumeric characters (maximum 32,767)
Performed by Alpha 45 Alphanumeric characters (maximum 45)
6 Discover 4th Dimension



Entering and Modifying Data
Entering and Modifying Data
We now need a way to get data into the database. In this tutorial, we 
will use the default input and output forms that 4D creates.

Creating Default 
Input and Output 
Forms

¨̈̈̈ To enter data in a record:

1 Go to the User environment by choosing User in the Use menu. 
The following dialog appears:

2 Click the Yes button.
After 4th Dimension creates automatic forms for you, your screen looks 
like this:

The Design environment’s Structure window is hidden behind the User 
environment window, but the Design environment is still running and 
available in the background. 4th Dimension is a “multi-process” 
application that allows you to have multiple environments open at the 
same time.
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Chapter 1  Creating a Database with 4D
You can have the Design environment, User environment, and several 
different Custom Menu environments all open at the same time. This 
feature is helpful for Rapid Application Development (RAD), because 
there is no time lost in going from “development mode” to “testing 
mode” to “runtime mode.”

3 Choose New Record in the Enter menu.
The input form for the [Albums] table appears; the cursor is already in 
the Album Title field.

4 Enter the following data.

Accept 
button

Cancel 
button

Field Name Data 
Album Title Rhapsody in Blue, An American in Paris
Musician George Gershwin
Format CD
Music Category Classical
Year Recorded 1988
Date Purchased 2/1/95
Purchase Price 12.95
Notes Live performance
Performed by Boston Pops Orchestra
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Entering and Modifying Data
Your screen now looks like this:

5 Click the Accept button.
Clicking Accept saves the record.

4D brings up a blank record for you to continue entering data. When 
you save a new record that you just created in the User environment, 
4D always assumes that you want to continue entering new records.

6 Click the Cancel button.
4D takes you back to the [Albums] Output form, where you see your 
new record listed.

Congratulations! You have created the first record in your album 
collection. Now, let’s see what we can do to automate your data entry. 

Accept 
button

Cancel 
button
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Chapter 1  Creating a Database with 4D
Automating Data Entry Using Standard Choice Lists
In a database, there are usually fields that have a limited number of 
possible entries. You can automate and standardize data entry by 
associating standard choice lists with these types of fields. In your 
[Albums] table, two fields fit that category:

Let’s set up standard choice lists corresponding to the fields 
[Albums]Music Category, [Albums]Format.

Creating Standard 
Choice Lists

¨̈̈̈ To create the Music Category choice list:

1 Go to the Design environment.
To return to the Design environment, click on any Design window or 
choose Design in the Use menu.

2 Choose List Editor... in the Tools menu.
The List Editor appears.

The List of Lists area lets you create choice lists. The Current List area 
lets you add items to a choice list.

Field Possible Entries
Music Category Jazz, Rock, Classical, Blues, Soul, Easy Listening, Country
Format CD, Cassette, Video, LP Record

Add item 
button

Add list 
button

List of Lists 
area

Current List 
area
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Automating Data Entry Using Standard Choice Lists
There are two Add buttons on this screen. The Add button in the Lists 
of Lists area (the Add list button) adds a new choice list; the Add 
button in the Current List area (the Add item button) adds an item to 
an existing choice list.

3 Click the Add button in the List of Lists area.

4D creates a new choice list; the cursor is in the List of Lists text area.

4 Type the name “Music Category.”

5 Click the Add button in the Current List area.
4D creates a new list item; the cursor is in the Current List text area.

6 Type the new item “Jazz.”

7 Continue adding list items: 
Rock, Classical, Blues, Soul, Easy Listening, Country.
For each new list item, click the Add button in the Current List area 
and type the name of the item.

Now you can sort the current choice list. We sort choice lists to make 
them an even more efficient tool for automating data entry.

¨̈̈̈ To sort the Music Category list:

■ Click the Sort button
4D sorts the Music Category choice list items in alphabetical order. The 
List Editor dialog box now looks like this:
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Chapter 1  Creating a Database with 4D
Now you can create and sort standard choice lists for the other 
category: Format.

¨̈̈̈ To create and sort the Format choice list:

1 Click the Add list button in the List of Lists area.

4D creates a new choice list; the cursor is in the List of Lists text area.

2 Type the name “Format.”

3 Click the Add item button in the Current List area.
4D creates a new list item; the cursor is in the Current List text area.

4 Type the new item “CD.”

5 Continue adding list items: 
Cassette, LP Record, Video.
For each new list item, click the Add button in the Current List area 
and type the name of the item.

6 Click the Sort button.
4D sorts the Format choice list items in alphabetical order.

For the sake of convenience, we will now create one more choice list 
that will be used in the next tutorial. This is the Nationality list.

¨̈̈̈ To create and sort the Nationality choice list, just repeat the process:

1 Click the Add list button in the List of Lists area.

2 Type the list name “Nationality.”

3 Click the Add item button in the Current List area.

4 Type the new item “USA.”

5 Continue adding list items: 
Canada, France, England, Japan, Germany.
For each new list item, click the Add button in the Current List area 
and type the name of the item.

6 Click the Sort button.
4D sorts the Nationality choice list items in alphabetical order.
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The List Editor now looks like this:

7 Click the Close Box to close the dialog box.
On the Macintosh, the close box is on the top left of the dialog box; on 
Windows, the close box is on the top right.

You have created three standard choice lists. Your next step is to 
associate the choice lists with fields (objects) in your database.

Associating a Choice 
List with a Field

After you associate a choice list with a field, 4D will automatically 
present the choice list any time you try to enter data into that field in 
the Input form.

¨̈̈̈ To associate a choice list with a field:

1 Click on the Database Structure window to make it active.
You can also choose Database Structure in the Tools menu.

2 Double-click the field Format.
The Field Properties dialog box appears. Note that the Attributes tab is 
in the front.
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3 Click the Choices & Help tab.
The Choices & Help window now appears in the Field Properties dialog 
box.

4 Click the Allow Choice List check box.

5 Choose Format from the Choice List pop-up menu.
The Field Properties dialog box now looks like this:

Choices & Help tab

Choice List pop-up menu
Allow Choice List 
check box
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6 Click the Apply button.
4D saves your changes. Leave the Field Properties dialog box open; you 
will use it again in the next step.

7 Click on the Music Category field in the Structure window.
Note that the Field Properties dialog box is updated; it now indicates 
that you are modifying the properties of the Music Category field.

8 Click the Allow Choice List button.

9 Choose Music Category from the Choice List pop-up menu.

10 Click the Apply button.

11 Click the Done button.

You have now associated choice lists with the fields Music Category 
and Format. Whenever you use those fields in data entry, searching, or 
sorting, their associated choice lists will appear and let you make a 
selection. 

REMINDER: We will associate field with the Nationality choice list in a later 
tutorial.
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Entering Data with 
Choice Lists

Let’s enter a record using the choice lists to speed up and simplify data 
entry. Using choice lists saves time, eliminates typing errors, and 
standardizes the spelling of data entry items. This makes the 
information easier to find later when you want to search for it.

¨̈̈̈ To enter data using choice lists:

1 Go to the User environment.
Click on the User Environment window or choose User in the Use 
menu.

2 Choose New Record in the Enter menu.
The [Albums] Input form appears.

3 Enter the following data:

Each time you move the cursor to a field that has an associated choice 
list, the list automatically appears in the middle of your screen. For 
example, when you go to the Music Category field, the following 
choice list appears:

Field Name Data 
Album Title Sound of Jazz
Musician Lionel Hampton
Format CD
Music Category Jazz
Year Recorded 1988
Date Purchased 12/14/96
Purchase Price 12.00
Notes Traditional Jazz Vibraphone (“vibes”)
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There are two ways to select an item in the choice list:

■ Type the first letter (or letters) of the name of the item you want to 
enter. The item is highlighted. Click the OK button. 

■ Double-click the item in the list.

After you select the item, it is automatically entered into the field

Your [Albums] Input form looks like this:

4 Click the Accept button.

5 Click the Cancel button to return to the [Albums] Output Form.

You now have two records in your database.

Congratulations! You have created standard choice lists to help you 
enter and modify database records. Now, let’s see what we can do to 
further expedite your data entry. 

Accept 
button

Cancel 
button
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Entering Data by Importing Records from a Document
If you are creating all of your data for the first time, you can enter it 
quickly and easily with the Input form and choice lists. However, there 
is another way to get data into 4D—by importing it. This can be 
especially useful if you have a great deal of data. 

Suppose you have been keeping track of your album collection in a 
spreadsheet. You can save your data from the spreadsheet as a text file, 
and import the text file into 4D. For the purposes of this tutorial, we 
have already created a text file that you can import. The name of the 
file is Albums.txt.

Here is how the Albums.txt text file looks in a text editor: 

Note Depending on the text file, the albums may not appear in the same 
order as shown.

The text file contains one record for each album. Within each record, 
the fields are separated by tabs and the end of the record is indicated 
by a carriage return. You can import files from text and several other 
formats, directly into 4D. 

¨̈̈̈ To import data from a text file:

1 Close the Albums.txt file.
If you were viewing the file with a text editor, be sure to close the file 
before attempting to use the file to import the information into 4D.

2 Choose Import Data… in the File menu.
The operating system’s standard Open File dialog appears.

3 Navigate to the 4th Dimension directory.
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Entering Data by Importing Records from a Document
During installation of 4th Dimension on your hard drive, the 4D 
Installer created a file called Albums.txt.

4 Double-click the Albums.txt icon to open the file.
There is another file, Musician.txt, in the same directory. Ignore the 
Musician.txt file for now; we will use it later.

The 4D Import Wizard appears, showing you the first few records so 
you can align columns in the import file with fields in your database.

5 Hold down the Shift key and choose Album Title in the pop-up menu 
above the first column of text.

Windows

Macintosh

Pop-up menu 
for the first field
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When you hold down the Shift key and choose a field, the Import 
Wizard assumes that the data in your import file is in the same order as 
the fields in your database. If some of the field choices are not correct, 
you can easily go to each pop-up list and change the field selection.

For help with specific importing challenges, see the 4th Dimension User 
Reference Manual.

6 Click the OK button.
4D returns to the [Albums] Output form, which displays the 19 records 
that you just imported. Note that the top of the window now says 
“Albums: 19 of 21,” which means that you now have 21 records in 
your database.
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7 Choose Show All in the Queries menu.
The [Albums] Output form lists all 21 records in the [Albums] table.

Congratulations! You have imported records from a text file into your 
database.

Finding Records in Your Database

Sorting Records in a 
Table

As you add more records to the database, you will notice that finding 
records becomes more difficult. Suppose, for example, that you have 
150 Album records in your database. If your monitor can display 15 
records per screen when displaying the Output form, you might have 
to scroll through as many as 10 screens to find a specific album. 

To make it faster and easier to find information in a large table, 
4th Dimension allows you to arrange the records in alphabetical, 
numerical, or date order. When you arrange the records in this way, 
you are putting the records into Sorted Order. 

¨̈̈̈ To sort records:

1 Choose Order by… in the Queries menu.
The Order By Editor appears.
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2 Double-click the field Musician in the Available Fields list.
The field appears in the Sorted Fields/Formulas list.

3 Double-click the field Year Recorded.
The field appears in the Sorted Fields/Formulas list.

4 In the Sorted Fields/Formulas list, click once on the Sort Direction 
arrow for the Year Recorded field.
The arrow changes to point downward. You have instructed 4D to sort 
your albums alphabetically by Musician, with the musician’s most 
recent albums first in the list. The Order by… Editor looks like this:

Sort 
direction 
arrows
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5 Click the Sort button.
The records are sorted alphabetically by musician, with the musician’s 
most recent albums first.

Although you cannot see the Year Recorded field on this screen, 4D 
also used that field in the sort.

For more information about the options in the Order By… Editor, see 
the 4th Dimension Design Reference Manual.

Querying by 
Example

Sorting the records and then scrolling to find a particular album works 
very well for a few dozen records, but it does not work well for larger 
numbers of records. As your music collection grows and the number of 
records increases into the hundreds, you will need a better way to find 
a particular record. 4D allows you to search for a particular record by 
bringing up a Query screen that resembles your data entry screen. You 
type in an example of the information that you're looking for, and 4D 
looks for matching records. That feature is called Query by Example.

¨̈̈̈ To find records by example:

1 Choose Query by Example... in the Queries menu.

The Query by Example wizard appears.
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You will find this wizard very easy to use, because it looks exactly like 
your input form. You will notice, however, that the cursor is an eye 
instead of the standard arrow pointer.

2 Click on the Music Category field.
The Music Category choice list appears. 

This demonstrates the advantage of associating a choice list with a 
field in the structure—any time you enter data into that field or search 
by that field, the choice list will appear automatically.
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3 Double-click the list item Classical.
Your screen looks like this:

4 Click the Accept button.
4D finds the Classical albums in your collection.

Indexing to Improve 
Search Performance

As the number of records in your database grows, these queries will 
become slower and slower, because the database has to look through 
the records sequentially (one-by-one), compare every record to your 
search example, and then display the records that you are looking for. 
Instead of doing a sequential search, 4D can make use of something 
called an Index. An index in a database works very much like an 
indexed Card Catalog in a library—Card catalogues are indexed by 
Author, by Title, and by Subject. If you want to find all the books about 
Classical music, you look in the Subject card file that contains the 
“C’s” and then under the “C’s” you scan alphabetically until you find 
“Classical.”

Accept 
button
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Databases use the electronic equivalent of card catalogues. In 
databases, instead of calling them card catalogues, we call them 
Indexes. Classical will appear in the Music Category Index, and CD 
will appear in the Format index. When you search by example for CD’s 
of Classical music, the database will quickly find all the records that 
meet both conditions: “Classical” Music and “CD” Format.

¨̈̈̈ To set up some indexes in the [Albums] table.

1 Go to the Database Structure window in the Design environment.
Choose Design under Use menu, or click directly on the Structure 
window if it is already visible.

2 Double-click the Album Title field.
The Field Properties dialog box appears.

3 In the Attributes tab, click the Indexed check box.

4 Click the Apply button.
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The dialog box now looks like this:

5 Leave the Field Properties dialog box open, and repeat the same 
procedure with three additional fields:
Musician, Format, Music Category
Each time, you will:

■ Click on the field.

■ Click the Indexed attribute check box.

■ Click the Apply button.

Your Structure window now looks like this:

4D shows the names of the indexed fields in bold type. When you 
query these fields, the performance will be 10 to 100 times faster than 
it was before you indexed the fields.

6 Click the Done button to close the Field Properties dialog box.
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Summary
Congratulations! In this chapter, you have learned how to:

■ Create a table, create fields, and change the properties of fields.

■ Create standard choice lists.

■ Create default input and output (listing) forms.

■ Enter new records and modify existing records.

■ Import records from a document on disk.

■ Find records in your database.

■ Index fields to improve search performance.

If you want to take a break before going to the next chapter, be sure to 
Quit (Exit) 4D before turning off your computer. 
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2 Adding Tables and 
Creating Relations

Estimated time to complete: 30 minutes

In this chapter, you will learn how to design a relational database using 
4th Dimension. You will also learn some database terminology, such as 
relational database and one-to-many. When you have finished this 
chapter, you will know how to do the following:

■ Create a [Musicians] table to store information about musicians.

■ Define a relationship between the tables [Albums] and [Musicians].

■ Use several advanced options of the Form Wizard.

■ View and edit data from both tables on the same form.
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Understanding Relational Databases
As you have seen, a single-table database has some definite 
advantages— it is quick, simple, and easy to understand. Depending 
on how detailed you want to be in keeping track of your data, a single 
table may be sufficient. However, if you need more power, you can use 
4th Dimension as a relational database.

The Relational Database of your two tables looks like this.

Simply stated, a relational database is a collection of tables with the 
following characteristics:

■ Specialization: Each table “specializes” in storing a certain type of 
information. In the example shown, the [Albums] table stores 
information about albums, and the [Musicians] table stores 
information about musicians.

■ Key fields: Each table has a column called the “Key Field.” The data in 
this key field is unique—no two records will have exactly the same data 
in the key field. This unique quality is what makes it possible to 
distinguish one record in the table from all other records in the table. 

In the example shown, the key field for the [Albums] table is 
[Albums]Album Title. The key field for the [Musicians] table is 
[Musicians]Musician Name.

■ Indexed: Each key field is indexed for fast searches.

■ Relations: Some of the tables are related to each other, so that they can 
share information. That is the reason for the term relational database.

... ...Musician Name Year of Birth Nationality

... ...Album Title Musician Name

Musicians

Albums
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■ Duplicated related fields: To identify the relationships, we copy the 
key field data into the related records. For example, when we enter 
records related to the musician Johnny Mathis into [Albums], we copy 
Johnny Mathis’ name into the [Albums] table record. This makes it 
possible for us to match or relate [Albums] information to [Musicians] 
information.

Note For several technical reasons, many professional database designers 
prefer to use a sequence number as the unique field, instead of using 
real-world data such as a name. For example, you can assign each 
album a unique ID number, and use that number as the unique key 
instead of the title of the album. You can set this up and let 4D keep 
track of the unique number sequences for you. In the 4th Dimension 
folder, there is an expanded example, “MusicPro,” in which we show 
you how to use automatic sequence numbers. For detailed information 
on setting up unique ID numbers, see the 4th Dimension Design 
Reference Manual.

Advantages of a Relational Database
Now that you understand the basic idea of a relational database, let’s 
briefly discuss the advantages of having a relational database.

Data Lookups Instead of re-typing the same data over and over, you can use a relation 
to look up the data and display where you need it. In the MyMusic 
database, we can type in the musician information one time in a table 
called [Musicians]. After that, instead of retyping the musician’s name 
for each record in the [Albums] table, we can let 4D automatically copy 
this information into the record for us. Not only does this save time, 
but it also eliminates typing mistakes, making our data entry more 
consistent and more accurate.

Flexibility You gain flexibility with a relational database, because you don’t need 
to know in advance how many albums you will have by a musician, or 
how many songs there will be on an album. If you have one album or 
one hundred albums by the same musician, your system can handle it.
31Discover 4th Dimension



Chapter 2  Adding Tables and Creating Relations
Analysis and 
Reporting

Analysis and reporting capabilities with a relational database are far 
more powerful than with a single-table database. You can look at the 
information in many different ways. For example, suppose you are 
planning a party and you want to schedule your music. You can ask 
your relational database the following questions:

■ How many Easy Listening CD’s do I have?

■ I want to play Beethoven’s music during dinner. Which Classical CD’s 
have selections that were written by Beethoven?

■ After dinner, I want to play dance music—Rock and Soul. Give me a list 
of my Rock and Soul albums.

This is just a small sample of the types of answers you could get from a 
relational database.

Scalability Scalability is the ability of a database to grow with your needs. 
Although we have used a two-table database in our example, real-life 
relational databases can be much larger in scale.

You can continue to add tables to your database as your information 
storage needs grow and change. The current version of 4th Dimension 
allows you to create 256 tables and thousands of subtables.

Note To find out how to create and use subtables, consult the 4th Dimension 
Design Reference Manual.

When you finish this tutorial, you will have a very handy tool for 
storing information about your personal albums; however, if you want 
to take it farther, you can. In addition to the [Musicians] and [Albums] 
tables that we cover in this tutorial, the expanded MusicPro example 
in the Example Databases folder contains the following table:

■ The [Album_Songs] table stores information about the songs on an 
album. You can use this table to find all the different renditions of the 
same song: the album, the track, the tempo, and the length (in 
minutes) of that version of the song.

Thus, scalability—the ability to expand your database as your needs 
expand—is one of the primary advantages of the relational model.
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Creating a Second Table
To store information about the performers on your albums, you will 
create a table called [Musicians].

Creating the Table

¨̈̈̈ To create a table:

1 Choose New Table… in the Structure menu.
The cursor turns into a small icon that looks like a miniature structure 
table.

2 Click on any blank space in the database structure window.
4D creates a new table and gives it the default name “Table2.”

3 Double-click the name Table2.
The Table Properties dialog box appears.

4 Highlight the name Table2 and replace it with the name “Musicians.”
For information about the other options in the Table Properties dialog 
box, see the 4th Dimension Design Reference.

5 Click the Apply button.
4D saves your changes.

6 Click the Done button to close the Table Properties dialog box.
The structure window displays the renamed table. You are now ready 
to create the fields for this table.
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Creating Fields

¨̈̈̈ To create new fields:

1 Double-click in the first box in the Fields area of the [Musicians] table 
to create a new field.
The Field Properties dialog box appears, with the Attributes tab 
window showing. The default name of this first field is “Field1.” We 
will rename this first field “Musician Name.”

2 Change the field name to “Musician Name.”

3 Make the field type Alpha, the length 45.

4 Click the following field attribute check boxes:
Mandatory, Indexed, and Unique to turn them all On.

The settings for the Musician Name field look like this:

5 Click the Apply button.

6 Create the remaining fields for the [Musicians] table.

Field Type pop-up menu

Field Length

Attributes tab

Field name Field type 
and length Attributes Remarks

Year of Birth Integer
Country of Birth Alpha 20 Indexed: 

Choice List
Use the “Nationality” choice list

Year Deceased Integer
Notes Text Up to 32,000 characters
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Each time you create a field, do the following:

■ Type the field name.

■ Choose the field type from the pop-up menu.

■ Change the field length, if applicable.

■ Click the Apply button.

7 Associate the Nationality choice list with the Country of Birth field.
Remember the Nationality choice list that we created in the last 
tutorial. We will now associate it with the Country of Birth field in the 
[Musicians] table.

To refresh your memory, here are the steps for associating the choice 
list with a field:

■ Double-click the field name [Musicians]Country of Birth in the 
structure window. This brings up the Field Properties dialog box.

■ Click the Choices & Help tab to display the Choices & Help tab 
window.

■ Click the Allow Choice List check box to turn it On.

■ Choose Nationality in the Choice List pop-up menu.

■ Click the Apply button.

The Field Properties dialog looks like this:

8 Click the Done button.
When you click the Done button, 4th Dimension closes the Field 
Properties dialog box.
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In the structure window, the table definition for [Musicians] now looks 
like this:

Establishing the Relationship Between Two Tables
Now that you have the [Albums] and [Musicians] tables, you are ready 
to establish the relationship between them. Each musician could 
record several albums, so you have a “one-to-many” relationship 
between [Musicians] and [Albums].

¨̈̈̈ To define this relationship:

1 In the table [Albums], click the field name [Albums]Musician.

2 Drag a line from the field [Albums]Musicians to the field 
[Musicians]Musician Name.

Important: When defining relations, always drag the relationship line 
from the Many table to the One table. 

Names of indexed fields 
are in bold type
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When you release the mouse, the Relation Properties dialog box 
appears, with the Definition tab window showing.

3 Make sure that all of the check boxes are selected to be On.
Click to select: Auto Wildcard support, and Auto One to Many.
All check boxes should be selected. So far, the Relation Properties 
dialog box looks like this:

4 Click the Control tab to set your Lookup Control options.

5 Highlight the field Country of Birth as your Wildcard Choice.

6 Click the Apply button to save the changes.
37Discover 4th Dimension



Chapter 2  Adding Tables and Creating Relations
The dialog box now looks like this:

For information about the other options in the Relation Properties 
dialog box, see the 4th Dimension Design Reference Manual.

7 Click the Done button to close the window.
Your structure window now looks like this:

Congratulations! You have just created your first One-to-Many relation 
in 4th Dimension!
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Adding Data to the New Table
Before you use the new relation, you need to add some data to your 
new [Musicians] table. First you will create a new record to test the 
Input form, then you will import some additional records, as you did 
for the [Albums] table. 

¨̈̈̈ To create the first record:

1 Click on the User environment window, or choose User in the Use 
menu to go to the User environment.
The following dialog appears:

2 Click the Yes button.
When you go to the User environment, 4th Dimension returns you to 
the Output form of the [Albums] table.

3 Display the List of tables dialog box.
In the User environment, you can use the List of tables dialog box to 
“jump” to any table in your database. Here are the shortcut keys to 
present the List of tables dialog box:

Platform To present the List of tables dialog box
Windows Hold down the Ctrl key and press the Space bar
Macintosh Hold down the Command key and press the Space Bar
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4 Click the word Musicians to go to the[Musicians] table.
You jump to the [Musicians] table.

The screen informs you that no records are selected for the [Musicians] 
table.

5 Choose New Record in the Enter menu.

The Input form for the [Musicians] table appears; the cursor is already 
in the Musician Name field. 

4th Dimension created this form for you automatically!

Note If the List of tables dialog box is still in the front of your screen, just 
click on the Input form to bring it forward.
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6 Enter the following data:

Your screen now looks like this:

7 Click the Accept button to save the record.

4th Dimension saves the record and brings up a blank record for you to 
continue entering data. When you save a new record that you just 
created in the User environment, 4D always assumes that you want to 
continue entering new records.

8 Click the Cancel button.
4th Dimension takes you back to the [Musicians] Output form, where 
you see your new record listed.

Field Name Data 
Musician Name Johnny Mathis
Year of Birth 1935
Country of Birth USA
Date Deceased
Notes Born in Texas, raised in San Francisco. 

Started music career in 1956.

Accept 
button

Cancel 
button
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Importing Records into the Table
In Chapter 1, you imported data into the [Albums] table. Now, you will 
import data into the [Musicians] table. We have already created a text 
file that you can import. The name of the file is Musician.txt.

The text file contains one record for each musician. Within each 
record, the fields are separated by tabs. The end of the record is 
indicated by a carriage return. 

¨̈̈̈ To import the text file into 4th Dimension:

1 Choose Import Data… in the File menu.
The operating system’s standard Open File dialog appears.

If you are not already in the 4th Dimension directory where the file 
Musician.txt is located, you will have to navigate to that directory.

2 Double-click the file Musician.txt to open it.
The 4D Import Wizard appears, showing you the first few records so 
you can align the columns in the Musician.txt import file with the 
fields in your database.

Windows

Macintosh
42 Discover 4th Dimension



Importing Records into the Table
3 Hold down the Shift key and choose Musician Name in the pop-up 
menu above the first column of text.
The screen looks like this:

When you hold down the Shift key and choose a field, the Import 
Wizard assumes that the data in your import file is in the same order as 
the fields in your database. If some of the field choices are not correct, 
you can easily go to each pop-up list and change the field selection.

For additional information, and for help with specific importing 
challenges, see the 4th Dimension User Reference Manual.

4 Click the OK button.
4D returns to the [Musicians] Output form, which displays the 20 
records that you just imported. Note that the top of the window now 
says “Musicians: 20 of 21,” which means that you now have a total of 
21 records in your database.
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5 Choose Show All in the Queries menu.
The [Musicians] Output form displays all of the records in the 
[Musicians] table.
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Creating a Relational Data Entry Form
Your next step is to create a data entry form that enables you to enter 
and view data from both tables at the same time. Using the Form 
Wizard, you will first create a subform in the [Albums] table; then you 
will add the subform to your [Musicians] Input form. The relational 
Input form will look like this:

Creating a Subform 
in a Table

¨̈̈̈ To create a subform in the [Albums] table:

1 Go to the Design environment by clicking on any Design environment 
window, or by choosing Design in the Use menu.

2 Choose Explorer in the Tools menu to present the Explorer window.

3 Click the Forms tab to bring it to the front.
[Albums] should already be selected. If it is not, select it. Note the 
thumbnail image of the [Albums] table on the right.

Main Input Form - [Musicians] table

Subform - [Albums] table
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4 Click the New button
The Form Wizard appears.

Every form in 4th Dimension is associated with a table. This form will 
be associated with your One table, the [Musicians] table.

5 Choose Albums in the New Form for Table: pop-up menu. It may 
already be selected.

6 In the Form Name: text box, change the form name to “Subform.”

7 Choose List Form in the Form Type pop-up menu.

8 Choose Simple (subform) in the Template used pop-up menu.

9 In the Available Fields list, double-click to select each of the following 
fields: Album Title, Format, Music Category.

Note You may have noticed that there is an Advanced... button on the Form 
Wizard. This button gives you access to several advanced form design 
features in 4th Dimension. To learn more about the Form Wizard, see 
the 4th Dimension Design Reference Manual.
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So far, your screen looks like this:

10 Click the Edit button.
4th Dimension opens your new subform in the Design environment, 
along with two form design palettes.

4D only shows you a small portion of the subform. To see the rest of 
your fields, you can use the scroll bar or expand the window.
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Adding the Subform 
to the Main Input 
Form

The next step is to drag the subform onto the Musicians Input form in 
order to see a list of all the albums by a particular musician.The drag 
operation will look like this:

¨̈̈̈ To drag the subform onto the [Musicians] Input form:

1 Choose Explorer in the Tools menu.
The 4th Dimension Explorer appears, with the Forms tab showing.

Main Input Form - [Musicians] table
Subform from [Albums]

Windows

Macintosh

Expand/
Collapse 
button

Expand/
Collapse 
button
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Note If the list of forms for each table is not expanded to display all the 
forms for each table, click the Expand/Collapse button to show them.

2 Click the [Musicians] Input form icon.
Note the thumbnail image of the [Musicians] Input form on the right 
side of the Explorer window.

3 Double-click the [Musicians] Input form icon to open the form
The [Musicians] Input form appears on your screen.

4 Expand the size of the Input form window so you can see the bottom 
of the form. 
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5 Choose Explorer..., again, in the Tools menu.

6 Click the [Albums] Subform icon.

Note the thumbnail image of the [Albums] subform on the right side 
of the Explorer window.

7 Arrange your screen so that the [Musicians] Input form is visible on 
the left, and the Explorer is visible on the right.

8 Click and drag the [Albums] Subform icon to the bottom of the 
[Musicians] Input form.
You will see a small rectangle at the cursor as you drag.

When you release the mouse button, you will see that the subform is 
now in the Input form. In 4D terminology, the subform is now an 
“Included area” on the [Musicians] Input form. 

9 Move the Subform to align it on the [Musicians] Input form.
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Your screen should look like this:

Designating the 
Full-Page Form

Now that you have the [Albums] subform as an included area in the 
[Musicians] Input form, you will want to use it to enter information 
about several albums by a given musician.

In 4D, you can double-click an included area to present a full-page 
form associated with it. This is useful for data entry in a subform. 

You will designate the [Albums] Input form as the full-page form that 
will appear when you double-click the included [Albums] subform.

¨̈̈̈ To assign the full-page form of an included area:

1 Choose Explorer... in the Tools menu.

2 While pressing the Shift key, click and drag the [Albums] Input form 
icon into the included area on the [Musicians] Input form.
This assigns the [Albums] Input form to be used by the [Albums] 
subform.

3 Double-click the subform included area in the [Musicians] Input form.
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The Object Properties dialog box appears.

4 Click the check box Double Clickable to turn it On.
For an description of the other options in the included area Object 
Properties dialog box, see the 4th Dimension Design Reference Manual.

5 Click the Close Box to close the window.
The close box is at the top right of the window on Windows, and at the 
top left of the window on Macintosh.

Testing the New 
Form

Let’s go back to the User environment and see how the relational form 
works.

¨̈̈̈ To test the new relational form:

1 Choose User in the Use menu.
4D takes you to the [Albums] table.

2 Display the List of tables dialog box.
In the User environment, you can use the List of tables dialog box to 
“jump” to any table in your database. Here are the shortcut keys to 
present the List of tables dialog box:

the full-page form

the subform in the 
included area

Platform To present the List of tables dialog box
Windows Hold down the Ctrl key and press the Space bar
Macintosh Hold down the Command key and press the Space Bar
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3 Click the word Musicians to go to the[Musicians] table.
You jump to the [Musicians] Output form. 4D lists all the records.

4 Double-click the record for Nat King Cole.

The [Musicians] Input form appears. Note the included area subform 
showing the album information.
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Adding a Record in 
the Subform

You can add more album information for this musician, using the 
[Albums] subform in the [Musicians] Input form. Remember, you 
associated the [Albums] Input form with this subform.

¨̈̈̈ To add another [Album] record:

1 Double-click on a blank line in the included area subform.
The [Albums] Input form appears. Note that the musician’s name is 
already in the form.

2 Enter the following data.

Accept 
button

Cancel 
button

Field Name Data 
Album Title Nature Boy
Musician Nat King Cole (tab through this field—it is 

already there)
Format LP
Music Category Easy Listening
Year Recorded 1951
Date Purchased 2/1/96
Purchase Price 13.50
Notes
Performed by
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The [Album] Input form now looks like this:

3 Click the Accept button.
Clicking Accept saves the new [Album] record. 4D brings up a blank 
record for you to continue entering data.

4 Click the Cancel button to return to the main [Musicians] Input form.
Both albums are now listed in the subform.

5 Click the Accept button in the [Musicians] Input form.
The record is saved. You return to the [Musicians] Output form.

Accept 
button

Cancel 
button

Accept 
button
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What's Next?
Now that you have the basics, we will expand your knowledge. In the 
next chapter, you will learn to use some of the advanced features of 
4th Dimension to create your own customized reports, labels, and 
charts.

Summary
Congratulations! In this chapter, you have learned how to:

■ Create a [Musicians] table to store information about musicians.

■ Define a relationship between the tables [Albums] and [Musicians].

■ Use several advanced options of the Form Wizard.

■ View and edit data from both tables on the same form.

If you want to take a break before going to the next chapter, be sure to 
Quit (Exit) 4D before turning off your computer. 
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and Graphs

Estimated time to complete: 30 minutes

One of the purposes of every database is to generate reports. In this 
chapter, you will learn how to:

■ Create a list of your albums, using the Quick Report Editor.

■ Print labels for your album collection, using the Label Wizard.

■ Create two and three-dimensional charts to see how much you have 
invested in your collection, using the Chart Wizard and 4D Chart.

Creating a Quick Report
Now that you have a database of your album collection, you want to 
print a report list of your albums. You do so using the Quick Report 
Editor.

¨̈̈̈ To get to the Quick Report Editor:

1 Display the List of tables dialog box.
In the User environment, you can use the List of tables dialog box to 
“jump” to any table in your database. Here are the shortcut keys to 
present the List of tables dialog box:

Platform To present the List of tables dialog box
Windows Hold down the Ctrl key and press the Space bar
Macintosh Hold down the Command key and press the Space Bar
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2 Click the word Albums to go to the [Albums] table.
You jump to the [Albums] Output form. The form lists all the records.

3 Choose Quick... in the Report menu.
The Quick Report Editor appears.

The Quick Report Editor is divided into five areas.

■ Select the fields area

■ Sort area

■ Cell summary area

■ Column attributes area

■ Report design area

Report design 
area

Select the fields 
area

Sort Order 
area

Cell Summary 
area

Column Attributes 
area
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Building the Report Let’s say that you want to print a report that contains the following 
fields: Album Title, Musician Name, Music Category, Format, and Pur-
chase Price.

¨̈̈̈ To build the report:

1 Double-click the field Album Title in the Select the fields area.

2 While the column is still highlighted, click the Sorted check box.

3 Double-click the following fields to add them to your report:
Musician, Format, Music Category, Purchase Price.
As you double-click each column, it is added to your report. Your 
report now looks like this:

4 Click the Scroll Bar right arrow or expand the window so you can see 
the column Purchase Price.
The Purchase Price column should already be highlighted. If it is not, 
click at the top of the column to highlight it.

5 Click the Sum button in the Cell Summary area.

Sum button
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6 Choose Print Preview in the File menu.
The Print Preview window appears.

7 Click the Magnifying Glass button if you want to examine the report 
closely.

8 Click the Stop button.
4D returns to the Quick Report Editor.

If you want to print this report from time to time, you could save this 
report and use it again. To print the report, you would simply load the 
report design and print it again. The printed output would reflect any 
changes you had made to the database in the meantime. For more 
information, refer to the 4th Dimension User Reference Manual.

9 Choose Close in the File menu.
4D returns to the [Albums] Output form.

Stop button

Magnifying Glass 
button
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Printing Labels
Your next project is to create labels for your CD collection. Perhaps you 
noticed that some of the plastic cases were cracking, and you think 
that they take up too much room. You want to move your CD’s into 
vinyl covers and soft plastic envelope pages. To keep track of the 
albums, you decide to print labels for the envelope pages. 

Each label will contain the following information:

■ Album Title

■ Musician

■ Music Category

You can quickly and easily make these labels using the 4D Label 
Wizard.

¨̈̈̈ To get to the Label Wizard:

■ Choose Labels... in the Report menu.
The Label Wizard appears, with the Label tab in front.

Label tab

Labels Page 
tab

Align 
Left 
icon

Label 
Design 
area
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Setting Alignment 
Options

Before you put any objects on your labels, you need to set your 
alignment options so that you are working with the correct size label.

To set the alignment options:

1 Click the Labels Page tab in the Label Wizard.
The Labels Page window appears:

This window gives you every alignment option you need in order to 
print any label on any printer.

In our example, we will print Avery™ 5160 labels. These labels are 
1” high by 2 5/8” wide, and there are 30 labels on a sheet

Labels Page 
tab
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2 Starting from the top of the window, set the following options:

Your settings look like this:

Now you are ready to actually design the labels.

Option Setting
Orientation Portrait
Labels Order Left to Right
Labels Across 3
Labels Down 10
Label Size On
Page Size Off
Automatic resizing Yes
Top Margin 40
Left Margin 26
Label Width Let the Wizard set this automatically.
Label Height Let the Wizard set this automatically.
Horizontal Gap 28
Vertical Gap 0
Unit Points
Labels per record 1
Standard code (Leave blank)
Method to apply No Method
Apply once per record
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Designing the 
Labels

¨̈̈̈ To design the labels:

1 Click the Label tab to go back to the Label design page.

2 Drag the field Album Title so that it is positioned near the top of the 
label in the label design area.

3 Drag the field Musician to the label.

4 Drag the field Music Category to the label.

5 Choose Select All in the Edit menu.

6 Click the Align Left icon.
Your label looks like this:

7 Choose Times in the Font pop up menu.

8 Click Left in the Justification pop-up menu.

Printing the Labels For this tutorial, we will just preview the page of labels on screen.

¨̈̈̈ To print the labels:

1 Click the Print button.

2 In your operating system’s Print dialog box, check to make sure that 
the Preview on Screen option is selected, and then click the Print 
button or OK.
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The page of labels is previewed on screen.

3 Click the Stop button to return to the [Albums] Output form.

Stop button
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Graphing Your Data
The 4D Chart Wizard enables you to examine your data with charts 
and graphs, using the built-in 4D Chart Plug-in. Let’s take a look.

¨̈̈̈ To get to the Chart Wizard:

■ Choose Graph... in the Report menu.
The Chart Wizard appears, showing the Chart type tab.

Creating a Pie Chart Let’s start with a simple, two-dimensional pie chart.

¨̈̈̈ To create a pie chart:

1 Click the 2D Pie Chart button in the Chart Type tab.

2 Click the Data Selection tab.

2D Pie Chart 
button

Data selection 
tab
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The Data Selection window appears.

Since this a two-dimensional chart, note that there are two data areas. 

You want to see the relative size of your investment in each category of 
your music collection, i.e., the percentage in Easy Listening, in Rock, in 
Soul, and so on.

3 Double-click the field [Albums] Music Category.

4 Double-click the field [Albums] Purchase Price.
Your choices are entered into the data areas:

5 Click the OK button.

Data areas
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Your chart looks like this:

6 Choose New in the File menu of the Chart Wizard window.

4D asks if you want to save the changes to the chart.

7 Click the Don’t Save button.
We will now create another type of chart.

4D Chart 
menu bar

4D 
menu bar
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Creating a Three-
Dimensional Chart

Suppose you want to create a chart of your dollar investment in your 
music collection, based on type of music and type of media. You want 
to see the total investment in rock videos, rock CD’s, blues LP records, 
and so on. Now, you will create a three-dimensional triangle chart. 

If you are continuing from the previous step, you have a blank chart 
window on your screen.

¨̈̈̈ To create a three-dimensional triangle chart:

1 Click the Chart Type icon.
The Chart Wizard appears, showing the Chart Type window.

Chart Type 
icon

3D Triangle Chart 
button

Data selection 
tab
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2 Click the 3-D Triangle Chart button at the bottom left of the window.

3 Click the Data Selection tab.
The Data Selection window appears. This time it looks different— 
because you are creating a 3-D chart, there are three data areas.

4 Double-click the field [Albums] Format.

5 Double-click the field [Albums] Music Category.

6 Double-click the field [Albums] Purchase Price.

Your choices are entered into the data areas.

7 Click the OK button.

Data areas
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Your 3-D chart looks like this:

Note Your chart may look somewhat different, depending on how your 
database categories are arranged.

8 Click the Close Box of the 4D Chart window.
The Close Box is at the top left of the 4D Chart window on the 
Macintosh, and at the top right of the window on Windows.

4D asks if you want to save the changes to the chart.

9 Click the Don’t Save button.
We return to the [Albums] Output form.

Congratulations! You have created your first 2-D and 3-D charts in the 
4D Chart Wizard. 

May we suggest that you come back to this tool later and explore on 
your own. You will find that, like the other 4th Dimension Wizards, the 
Chart Wizard is powerful, flexible, and easy to use.
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What's Next?
In the next chapter, you will learn how to publish your music 
collection on the Web.

Summary
Congratulations! In this chapter, you have learned how to:

■ Create a list of your albums, using the Quick Report Editor.

■ Print labels for your album collection, using the Label Wizard.

■ Create two and three-dimensional charts to see how much you have 
invested in your collection, using the Chart Wizard and 4D Chart.

If you want to take a break before going to the next chapter, be sure to 
Quit (Exit) 4D before turning off your computer. 
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4 Publishing Your Database 
on the Web

Estimated time to complete: 30 minutes

In this chapter, you will publish your music collection database on the 
World Wide Web. When you have finished this chapter, you will know 
how to do the following:

■ Create a Custom Menu environment.

■ Create web-aware forms.

■ Publish the data on the Web.

Creating a Custom Menu Environment
Until now, you have worked in the 4D Design and User environments. 
Within a Custom Menu environment, you can use special menus that 
you create for special uses in your database. One of the uses of a 
custom menu is for publishing databases on the Web.

To publish a 4D database on the Web, you must first create a Custom 
Menu Environment that will enable you to list your albums by simply 
selecting a menu command. You create a custom menu item in the 
Menu Bar Editor; you then create the method for this item using the 
Method Editor. 
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Creating a Custom 
Menu Item

¨̈̈̈ To create the new menu item:

1 Choose Design in the Use menu.

2 Choose Menu Bar Editor... in the Tools menu.
The Menu Bar Editor appears.

Now you can create a custom menu item.

3 Click the Add button in the List of Menu Bars area.
The name “Menu Bar#1” appears in the list.

4 Click the Add Item button.
A text box appears, so you can add an item to the File menu.

5 Type the word “List Albums” to name this menu item.
Now “List Items” is a menu item in the File menu.

6 Click in the Method Name box and type “List Albums”.
This associates the menu item with a method, which you will define.

Start a New 
Process 
check box

Add button Add item button

Method 
Name 
text box
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So far, your screen looks like this:

Creating the 
Method

Now you can define the “List Albums” method corresponding to the 
“List Items” menu item you just created.

¨̈̈̈ To create the method for the custom menu item:

1 Leaving the Menu Bar Editor open, choose New Method... in the 
Design menu.
The New Method dialog box appears, so you can name the method. 
The default name “Method1” is in the text box.

2 Name the method “List Albums”.
The method name must be exactly the same as the method name you 
type in the Menu Bar editor.

3 Click the OK button.
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The Method Editor appears.

In the next few steps, you will create a simple, two-line 4D Method.

4 Type “All Records(”
That is, the words “All Records” followed by an open parenthesis 
symbol.

5 Leave the cursor inserted (blinking) after the open parenthesis 
symbol, and click on the table name Albums in the Tables & Fields list.
4D inserts the table name [Albums].

6 Type a close parenthesis “)” symbol and press Enter (Windows) or 
Return (Macintosh).
So far, your method looks like this:

As you can see, 4th Dimension changed the style of the ALL RECORDS 
command to bold, upper-case.

7 Type “Modify Selection(”
That is, the words “Modify Selection” followed by an open parenthesis 
symbol.

8 Leave the cursor inserted (blinking) after the open parenthesis 
symbol, and click on the table name Albums in the Tables & Fields 
area.
4D inserts the table name [Albums].

Method editing 
area

Tables and 
fields list
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9 Type “;*)” 
That is, a semicolon, an asterisk, and a close parenthesis symbol.

10 Press Enter (Windows) or Return (Macintosh).
4D changes the words MODIFY SELECTION to all upper-case. 

The method editor now looks like this:

11 Choose Save Method: List Albums in the File menu.

12 Click the Close box to close the method window.
The close box is in the upper left on the Macintosh and the upper right 
on Windows.

13 Close the Menu Bar Editor.

Congratulations! You have just created your first method in 
4th Dimension! Now you can go to the Custom Menus environment 
and test your application.

Testing the Method

¨̈̈̈ To test your new application:

1 Choose User in the Use menu.
In the User environment, 4th Dimension adds another option to the 
Use menu—the Custom Menus option.

2 Choose Custom Menus in the Use menu.
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The Custom Menus window appears, showing the 4D logo.

3 Choose List Albums in the File menu.
This is your new menu item.

The [Albums] Output form appears.

4 Click the Done button to close the Output form.
4D returns you to the Custom Menus window.

Custom Menus 
window
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Creating Web-Aware Forms
You can publish any 4th Dimension database on the Web. In this 
section, you will learn how easy it is to create web-aware forms using 
the Form Wizard. Any form that you create using the Form Wizard’s 
Web-Aware” template will be optimized for display in Web browsers.

First you will create an Output form, then an Input form.

REMINDER: The previous exercise left you in the Custom Menus window. In 
order to create the forms, you must first get back to the Structure window in 
the Design environment of your database.

¨̈̈̈ To get to the Structure window:

1 Choose Quit from the File menu.
4D returns to the User environment.

2 Choose Design from the Use menu.
4D returns to the Design environment. The Structure window appears.

You can now create your web-enabled forms.

Creating a Web 
Aware Output Form

¨̈̈̈ To create a web-aware Output form:

1 Choose Explorer in the Tools menu to present the Explorer window.

2 Click the Forms tab to bring it to the front.
[Albums] should already be selected.
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3 Click the New button.
The Form Wizard appears.

4 Choose Albums in the New Form for Table pop-up menu.
The pop-up may already be set to Albums.

5 In the Form Name: text box, change the form name to “Web Output.”

6 Choose List Form in the Form Type pop-up menu.

7 Choose Web Aware in the Template used: pop-up menu.

8 In the Available Fields list, double-click the following fields, in order, to 
add them to the form: 
Album Title, Musician, Music Category, Format.
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So far, your selections in the Form Wizard look like this:

9 Click the Use button.
4D takes you to the User environment and displays your new 
web-aware [Albums] Output form. 4D saves it as the current Output 
form for the [Albums] table.

Whenever you create a new form and click the Use button, 4D 
automatically takes you to the User environment and sets the form as 
the Output form or Input form, as applicable.

You do not have to be concerned about the width of the form. Any 
form that you create using the Form Wizard’s Web-Aware template will 
be optimized for display in Web browsers. 4D automatically adjusts the 
width of the form to fit a standard Web browser when it publishes the 
form on the Web.
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Creating a Web 
Aware Input Form

¨̈̈̈ To create a web-aware Input form:

1 Go to the Design environment by clicking on the Structure window or 
choosing Design in the Use menu.

2 Choose Explorer in the Tools menu to present the Explorer window.

3 Click the Forms tab to bring it to the front.
[Albums] should already be selected.

4 Click the New button.
The Form Wizard appears.
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5 Choose Albums in the New Form for Table pop-up menu.
It may already be selected.

6 In the Form Name: text box, change the form name to “Web Input.”

7 Choose Detail Form in the Form Type pop-up menu.

8 Choose Web Aware in the Template used: pop-up menu.

9 Click the Select All Fields button.
Your selections in the Form Wizard look like this:

Note For this tutorial, we will use the form with the fields in their automatic 
order. However, if you want to rearrange the order of the fields on the 
form, you can do so by selecting a field in the Selected Fields list and 
dragging it to a different location in the list.

10 Click the Use button.
4D saves the form and sets it as your current Input form for the 
[Albums] table.

All Fields 
button
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4D returns to the [Albums] Output form in the User environment.

11 Double-click an [Albums] record.
Your new web-aware [Albums] Input form appears.

12 Click the Cancel button to return to the [Albums] Output form.

Cancel 
button
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Publishing a 4D Database on the Web
You are now ready to publish your 4th Dimension database on the 
Web. In order to publish any 4D database on the Web, there are three 
requirements:

■ Create at least one Custom Menu.
You have already done this.

■ Create web-aware input and output forms.
You have already done this.

■ In the Database Properties window, select the Web Server Startup 
option, Publish Database at Startup.
4D did this automatically. If you go to the Design environment and 
choose Database Properties in the File menu, you will see that the 
Publish Database at Startup option is already selected. Whenever you 
create a new database in 4D, that Web Publish option is automatically 
turned on.

¨̈̈̈ To check the Database Properties.

1 Go to the Design environment by clicking on any Design environment 
window, or by choosing Design in the Use menu.

2 Choose Database Properties in the File menu.

3 Click the Cancel button to return to the structure window.

Publish Database at Startup 
option
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Basic Requirements 
of the TCP/IP 
Networking 
Protocol

In addition to the 4D requirements mentioned, there is another 
requirement in order to publish your 4D database on the Web. You 
must install the TCP/IP networking protocol into the operating system 
on your computer. 

If you are running 4D on Macintosh, Windows 95, or Windows NT, the 
TCP/IP networking protocol comes as a part of the operating system. If 
it is not already installed, you can add TCP/IP to your configuration at 
no additional cost. If you are running a version of the Windows 3.1X 
operating system, you will have to purchase a “TCP/IP Stack.”

If your TCP/IP connection is an “Intranet” connection (the computers 
are physically on the same network, perhaps within the same 
building), you will not need to go through any Internet Service 
Provider (ISP) in order to publish the database. You just need to set up 
a valid TCP/IP addressing system. This means that you should make 
sure that all workstations are in the same Subnet—the first three sets of 
numbers in the TCP/IP Addresses are identical. 

Here is an example of valid TCP/IP addresses within the same Subnet:

In this case, the Subnet is 205.178.015 and the Subnet Mask is 
255.255.255.0.

4th Dimension 
TCP/IP Network 
Component

In order for 4th Dimension to use TCP/IP for networking, the 
4th Dimension TCP/IP Network Component must be installed. The 
following table tells you where the TCP/IP network component must 
be located.

If you did a normal installation of 4D (not a Custom install), then the 
TCP/IP Network Component was automatically installed.

If you have problems with TCP/IP, refer to the 4th Dimension Network 
Components Addendum.

Workstation TCP/IP Address
Web Server 205.178.015.080
Workstation1 205.178.015.199
Workstation2 205.178.015.107

Platform Location of TCP/IP Network Component
Windows The C:\Windows\ACI\Network
Macintosh Embedded inside the 4D application
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If your TCP/IP network components are set up properly, your TCP/IP 
properties windows should look similar to this.

Checking Web 
Services

If you have the TCP/IP Networking Protocol and the 4th Dimension 
TCP/IP Network Component properly installed on your Web Server 
machine, then you will be able to use your data over the Web.

If web services are properly initialized as far as 4th Dimension is 
concerned, the Stop Web Server option in the Web Server menu is 
enabled and Start Web Server is disabled. If web services are not set 
properly, the Start Web Server option is enabled.

Windows Macintosh
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Publishing Your 
Data

¨̈̈̈ To access your data on the Web:

1 Leave the database MyMusic running on your Web Server machine, 
and go to a second machine that already has a valid TCP/IP 
connection to the machine that is running 4D.

2 Launch a Web Browser on the second machine.
For our example, we will use Netscape Navigator™. Any Web browser 
will work just as well.

3 in the browser, type the 4D Web Server’s TCP/IP address in the 
following format: “http://NNN.NNN.NNN.NNN/”.
The “NNN” characters represent the numbers of the TCP/IP address of 
the Web Server. In our example, we are using the address 
205.178.15.199.

4 Press the Enter key (Windows) or the Return key (Macintosh).
In the Web browser, the File menu of your database looks like this:

5 Click the List Albums menu item.
The web-aware [Albums] Output form appears:
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Note how the columns have been adjusted for display in the Web 
browser. This is the benefit of using Web-Aware Templates.

6 Click on a record’s drill-down button.
The [Albums] Input form appears.

Drill-down 
button
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Congratulations! You have published your data on the Web!

For more information about the many options you have when 
publishing 4D databases on the Web, see the 4th Dimension Design 
Reference Manual.

Summary
Congratulations! In less than two hours of practice, you have 
successfully performed all of the following:

■ Created a relational database to track your personal music collection.

■ Created custom Input and Output forms to view the data.

■ Imported sample data records.

■ Created your own custom queries.

■ Created a custom report to print a list of your albums.

■ Designed your own labels for your CD holders.

■ Printed two- and three-dimensional charts to analyze your collection.

■ Created a multi-window, custom menu environment for your 
database.

■ Created forms for viewing your data on the World Wide Web.

■ Published your database on the Web.

If you want to learn about additional capabilities, refer to the other 
manuals provided with 4th Dimension.
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